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Chapter 386

Mixed Models Tests
for Two Proportions in
a 2-Level Hierarchical
Design (Level-2
Randomization)
Introduction
This procedure calculates power and sample size for a two-level hierarchical mixed-effects logistic regression in
which clusters (groups, classes, hospitals, etc.) of subjects are measured one time (cross-sectional) on a binary
variable. The goal of the study is to compare the two group proportions.
In this design, the subjects are the level one units and the clusters are the level two units. All subjects in a
particular cluster (level two unit) receive one of two possible interventions. This intervention is selected at
random. Note that a companion procedure power analyzes the other case in which the randomization occurs for
the level one units (the subjects).

Technical Details
Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 5, section 5.7.1, pages 177-179. The
hierarchical mixed-effects logistic regression model that is adopted is
log �
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is the binary response of the jth subject in the ith cluster.
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𝛿𝛿

is the treatment effect of interest.

𝛽𝛽0

is the fixed intercept.
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𝑋𝑋𝑖𝑖𝑖𝑖

is an indicator variable that is = 1 if cluster i is assigned to group 1 (treatment) and 0 if cluster i is
assigned to group 2 (control).

𝜎𝜎𝑢𝑢2

is variance of the level two (cluster) random effects.

𝑢𝑢𝑖𝑖
𝜌𝜌

is a random effect (subject-specific intercept) term for the ith cluster the is distributed as 𝑁𝑁(0, 𝜎𝜎𝑢𝑢2 ).

is the intraclass correlation (ICC), where 𝜌𝜌 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶�𝑌𝑌𝑖𝑖𝑖𝑖 , 𝑌𝑌𝑖𝑖𝑗𝑗′ � = (𝜎𝜎𝑢𝑢2 /(𝜎𝜎𝑢𝑢2 + 𝜋𝜋 2 /3)).

The test of significance of the 𝛿𝛿 coefficient in the logistic regression analysis is the test statistic of interest.
The power can be calculated using

where
𝐾𝐾𝑚𝑚
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is the number of clusters in group m, m = 1 or 2.
is the average number of subjects per cluster in both groups.
is K1 /𝐾𝐾2 .

𝑝𝑝1 +𝜆𝜆𝑝𝑝2
�.
1+𝜆𝜆

is �

This power function is used in a binary search algorithm to determine p1, K1, or M.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Effect Size, Power, K1, or M.
Under most situations, you will select either Power to calculate power or K1 to calculate the number of clusters.
Occasionally, you may want to fix the number of clusters and find the necessary cluster size.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary
search is made using an iterative procedure until an appropriate value is found. This search considers integer
values of M only.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard.
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha
that represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size – Number of Clusters and Subjects –
Number of Clusters
K1 (Number of Group 1 Clusters)
This is the number of clusters in group 1, which we have designated as the treatment group. The sample size for
this group is equal to the number of clusters times the number of subjects per cluster.
Range
This value must be a positive number.
It can be a decimal (fractional) number such as '12.7'. The resulting value of N1 will be rounded to an integer.
List
You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.
K2 (Number of Group 2 Clusters)
This is the number of clusters in group 2, which we have designated as the control group. The sample size for this
group is equal to the number of clusters times the number of subjects per cluster.
Range
This value must be a positive number.
It can be a decimal (fractional) number such as '12.7'. The resulting value of N2 will be rounded to an integer.
Using Multiples of K1
If you simply want a multiple of the value for group one, you would enter the multiple followed by "K1", with no
blanks. If you want to use K1 directly, you do not have to enter the leading "1". For example, all of the following
are valid entries:
10K1 2K1 0.5K1 K1.
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List
You can use a list of values such as "10 20 30" or "K1 2K1 3K1".

Sample Size – Number of Clusters and Subjects –
Number of Subjects Per Cluster
M (Number of Subjects Per Cluster)
This is the average number of items (subjects) per cluster in both groups.
Range
This value must be a positive number that is at least 1.
It can be a decimal (fractional) number such as '2.7'. The resulting values of N1 and N2 will be rounded to
integers.
List
You can use a list of values such as "100 150 200". A separate analysis will be run for each element in the list.

Effect Size
P1 Input Type
Indicate what type of values to enter to specify the effect size: P1 - P2. Regardless of the entry type chosen, the
test statistics used in the power and sample size calculations are the same. The value of P1 is calculated from the
value entered. This option is simply given for convenience in specifying the effect size.
The choices are
•

Proportions
Enter P1 (Group 1 Proportion|H1) and P2 (Group 2 Proportion).

•

Differences
Enter D1 (Difference|H1 = P1-P2) and P2 (Group 2 Proportion).

•

Ratios
Enter R1 (Ratio|H1 = P1/P2) and P2 (Group 2 Proportion).

•

Odds Ratios
Enter OR1 (Odds Ratio|H1 = Odds1/Odds2) and P2 (Group 2 Proportion).

P1 (Group 1 Proportion |H1)
Enter a value for the proportion in group 1 (the experimental or treatment group) under the alternative hypothesis,
H1. The power calculations assume that this is the actual value of the proportion.
You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1.
Note that values must be between zero and one and cannot be equal to P2.
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D1 (Difference|H1 = P1 – P2)
This option specifies the difference between the two proportions under the alternative hypothesis, H1. This
difference is used with P2 to calculate the value of P1 using the formula: P1=Diff+P2.
The power calculations assume that P1 is the actual value of the proportion in group 1 (experimental or treatment
group).
You can enter a single value such as 0.05 or a series of values such as 0.03 0.05 0.10 or 0.01 to 0.05 by 0.01.
Differences must be between -1 and 1. They cannot take on the values -1, 0, or 1.
R1 (Ratio|H1 = P1/P2)
This option specifies the ratio between the two proportions P1 and P2. This ratio is used with P2 to calculate the
value of P1 using the formula: P1=(Ratio) x (P2).
The power calculations assume that P1 is the actual value of the proportion in group 1 (experimental or treatment
group).
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25.
Ratios must be greater than zero. They cannot take on the value of one.
OR1 (Ratio|H1 = Odds1/Odds2)
This option specifies the ratio of P1 and P2, where P1 is the proportion in group 1 under the alternative
hypothesis. This ratio is used with P2 to calculate the value of P1 using the formula: P1 = R1 x P2.The power
calculations assume that P1 is the actual value of the proportion in group 1 (experimental or treatment group).
You may enter a range of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25. Ratios must be greater than zero.
They cannot take on the value of one.
P2 (Group 2 Proportion)
Enter a value for the proportion in group 2 (the control, baseline, standard, or reference group).
Values must be between 0 and 1.
You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.

Effect Size – Intracluster Correlation
ρ (Intracluster Correlation, ICC)
This is the value of the intracluster (or intraclass) correlation coefficient. It may be interpreted as the correlation
between any two observations in the same cluster. It may also be thought of as the proportion of the variation in
response that can be accounted for by the between-cluster variation.
Possible values are from 0 to just below 1. Typical values are between 0.0001 and 0.05.
You may enter a single value or a list of values.
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Example 1 – Calculating Power
Suppose that a two-level hierarchical design is planned in which there will be only one measurement per subject
and treatments will be applied to clusters (level-two units). The analysis will be a mixed-effect logistic regression.
The following parameter settings are to be used for the power analysis: P1 = 0.6; P2 = 0.5; ρ = 0.01; M = 20 or
30; α = 0.05; and K1 = K2 = 10 to 40 by 10.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Two Proportions in a 2-Level Hierarchical Design (Level-2
Randomization) procedure window. You may then make the appropriate entries as listed below, or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
K1 (Number of Group 1 Clusters) ........... 10 20 30 40
K2 (Number of Group 2 Clusters) ........... K1
M (Number of Subjects Per Cluster)....... 20 30
P1 Input Type ......................................... Proportions
P1 (Group 1 Proportion|H1) .................... 0.6
P2 (Group 2 Proportion) ......................... 0.5
ρ (Intracluster Correlation, ICC).............. 0.01

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Total Group 1 Group 2
Subjects Clusters Clusters
Power
N
K1
K2
0.45306
400
10
10
0.58262
600
10
10
0.74190
800
20
20
0.86672
1200
20
20
0.89211
1200
30
30
0.96434
1800
30
30
0.95855
1600
40
40
0.99151
2400
40
40

Cluster Group 1 Group 2
Size
Prop
Prop
M
P1
P2
20 0.6000 0.5000
30 0.6000 0.5000
20 0.6000 0.5000
30 0.6000 0.5000
20 0.6000 0.5000
30 0.6000 0.5000
20 0.6000 0.5000
30 0.6000 0.5000

Prop
Diff
P1-P2
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000

Odds
Ratio
OR
1.500
1.500
1.500
1.500
1.500
1.500
1.500
1.500

ICC
ρ
0.0100
0.0100
0.0100
0.0100
0.0100
0.0100
0.0100
0.0100

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

References
Ahn, C., Heo, M., and Zhang, S. 2015. Sample Size Calculations for Clustered and Longitudinal Outcomes in
Clinical Research. CRC Press. New York.
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N is the total number of subjects in the study.
K1 and K2 are the number of clusters in groups 1 and 2, respectively.
M is the average number of items (subjects) per cluster.
P1 is the proportion for group 1 (treatment group) assuming the alternative hypothesis.
P2 is the proportion for group 2 (control group). This is the proportion in the standard, reference, baseline, or control group.
Prop Diff = P1 - P2 is the difference in the group proportions assumed by the alternative hypothesis.
Odds Ratio = Odds1/Odds2 is the odds ratio assuming the alternative hypothesis.
ICC is the intracluster correlation.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements
Sample sizes of 25 in group one and 25 in group two, which were obtained by sampling 5 clusters
in group one and 5 clusters in group two with an average of 5 subjects per cluster, achieve 41%
power to detect a difference between the group means of at least 1. The standard deviation of
subjects is 1.00. The intracluster correlation coefficient is 0.010. A test based on a
mixed-model analysis is anticipated at a significance level of 0.050.

This report shows the power for each of the scenarios.

Plots Section

These plots show the power versus the cluster count for the two cluster size values.
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Example 2 – Calculating Sample Size (Number of Clusters)
Continuing with the last example, suppose the researchers want to determine the number of clusters needed to
achieve 90% power for both values of M.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Two Proportions in a 2-Level Hierarchical Design (Level-2
Randomization) procedure window. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ K1 (Number of Clusters)
Power ...................................................... 0.90
Alpha ....................................................... 0.05
K2 (Number of Group 2 Clusters) ........... K1
M (Number of Subjects Per Cluster) ....... 20 30
P1 Input Type ......................................... Proportions
P1 (Group 1 Proportion|H1) .................... 0.6
P2 (Group 2 Proportion) ......................... 0.5
ρ (Intracluster Correlation, ICC).............. 0.01

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Total Group 1 Group 2
Subjects Clusters Clusters
Power
N
K1
K2
0.90162
1240
31
31
0.90890
1380
23
23

Cluster Group 1 Group 2
Size
Prop
Prop
M
P1
P2
20 0.6000 0.5000
30 0.6000 0.5000

Prop
Diff
P1-P2
0.1000
0.1000

Odds
Ratio
OR
1.500
1.500

ICC
ρ
0.0100
0.0100

Alpha
0.050
0.050

This report shows the power for each of the scenarios.
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Example 3 – Calculating Sample Size (Number of Subjects)
Continuing with the last example, suppose the researchers want to determine the number of subjects per cluster
needed to achieve 90% power for all values of K1 and K2.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Two Proportions in a 2-Level Hierarchical Design (Level-2
Randomization) procedure window. You may then make the appropriate entries as listed below, or open
Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ M (Number of Subjects Per Cluster)
Power ...................................................... 0.90
Alpha ....................................................... 0.05
K1 (Number of Group 1 Clusters) ........... 10 20 30 40
K2 (Number of Group 2 Clusters) ........... K1
P1 Input Type ......................................... Proportions
P1 (Group 1 Proportion|H1) .................... 0.6
P2 (Group 2 Proportion) ......................... 0.5
ρ (Intracluster Correlation, ICC).............. 0.01

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Total Group 1 Group 2
Subjects Clusters Clusters
Power
N
K1
K2
0.90076
2140
10
10
0.90237
1400
20
20
0.90377
1260
30
30
0.90447
1200
40
40

Cluster Group 1 Group 2
Size
Prop
Prop
M
P1
P2
107 0.6000 0.5000
35 0.6000 0.5000
21 0.6000 0.5000
15 0.6000 0.5000

Prop
Diff
P1-P2
0.1000
0.1000
0.1000
0.1000

Odds
Ratio
OR
1.500
1.500
1.500
1.500

ICC
ρ
0.0100
0.0100
0.0100
0.0100

Alpha
0.050
0.050
0.050
0.050

This report shows the values of M needed for each scenario.
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Example 4 – Validation using Ahn, Heo, and Zhang (2015)
Ahn, Heo, and Zhang (2015) page 179 provide a table in which several scenarios are reported. We will validate
this procedure by duplicating the first two table entries.
The following parameter settings were used: Power = 0.80; P1 = 0.6; P2 = 0.4; ρ = 0.1; M = 10 and 20; ICC =
0.1; and α = 0.05. The reported values of K1 and K2 are 19 and 15. The realized power values are 0.812 and 0.826

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Two Proportions in a 2-Level Hierarchical Design (Level-2
Randomization) procedure window. You may then make the appropriate entries as listed below, or open
Example 4 by going to the File menu and choosing Open Example Template.
Design Tab
Solve For ................................................ K1 (Number of Clusters)
Power ...................................................... 0.80
Alpha ....................................................... 0.05
K2 (Number of Group 2 Clusters) ........... K1
M (Number of Subjects Per Cluster) ....... 10 20
P1 Input Type ......................................... Proportions
P1 (Group 1 Proportion|H1) .................... 0.6
P2 (Group 2 Proportion) ......................... 0.4
ρ (Intracluster Correlation, ICC).............. 0.1

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Total Group 1 Group 2
Subjects Clusters Clusters
Power
N
K1
K2
0.81229
380
19
19
0.82529
600
15
15

Cluster Group 1 Group 2
Size
Prop
Prop
M
P1
P2
10 0.6000 0.4000
20 0.6000 0.4000

Prop
Diff
P1-P2
0.2000
0.2000

Odds
Ratio
OR
2.250
2.250

ICC
ρ
0.1000
0.1000

Alpha
0.050
0.050

PASS calculates the same values of K1: 19 and 15. Note that the realized power values are identical.
(We noticed two typos in Table 5.9, page 179. The last two entries for p1 are 0.5 and 0.6. We believe these should
be 0.6 and 0.7.)
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